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1.0 Introduction 

 

1.1 Description of Assay 

Apoptosis, or programmed cell death, is a natural process of cellular self-destruction. Apoptosis is a part 

of routine cell turnover and tissue homeostasis, prevalent in epithelial cells, erythrocytes, and other cell 

types genetically programmed to have a limited life span.  It is also important in embryogenesis, 

maintenance of immune tolerance, and development of the nervous system. Apoptosis can be induced 

either by a stimulus, such as irradiation or toxic drugs, or by removal of a repressor agent. The cells 

disintegrate into membrane-bound particles that are then eliminated by phagocytosis. Problems with 

the regulation of apoptosis are thought to be linked to many cancers, degenerative diseases, and 

autoimmune diseases, making apoptosis a key target in many fields of clinical research. 

Necrosis is the death of cells or tissues from severe injury or disease, especially in a localized area of the 

body. Causes of necrosis include inadequate blood supply (as in infarcted tissue), bacterial infection, 

traumatic injury, and hyperthermia. 
 

Annexin V and propidium iodide are used to measure apoptosis and necrosis.  Annexin V is a member 

of the annexin family of intracellular proteins that binds to phosphatidylserine (PS) in a calcium-

dependent manner. PS is normally only found on the intracellular leaflet of the plasma membrane in 

healthy cells, but during early apoptosis, PS translocates to the external leaflet. Fluorochrome-labeled 

Annexin V can then be used to specifically target and identify the PS on the surface of apoptotic cells. 

Annexin V binding alone cannot differentiate between apoptotic and necrotic cells. Propidium Iodide 

(PI) solution is a membrane-exclusion dye that permeates cells with compromised cell membranes and 

binds to DNA. Early apoptotic and healthy cells with intact membranes will exclude PI, while late stage 

apoptotic and necrotic cells with compromised membranes are stained. Use of both Annexin V-FITC and 

PI allows researchers to characterize a cell population based on % normal, % apoptotic, and % necrotic 

/very late-stage apoptotic cells.  

For more information on apoptosis, several reference articles are available, including the those where Cellometer 
is referenced: 

 Elmore S. (2007). Apoptosis: A Review of Programmed Cell Death. Toxicol. Pathol. 35(4): 495-516.  

 Rastogi RP, et al. (2009). Apoptosis: Molecular Mechanisms and Pathogenicity. EXCLI Journal. 8:155-181 

 Berger EA, et al. (2013) HIF-1α Is Essential for Effective PMN Bacterial Killing, Antimicrobial Peptide 
Production and Apoptosis in Pseudomonas aeruginosa Keratitis. PLoS Pathogens 9(7) 

 Verma M, et al. (2013) Sirtuin-3 Modulates Bak/Bax Dependent Apoptosis. Journal of Cell Science 

126(1):274-88 

1.2 Materials and Reagents 

 CSK-0117-1 kit: 

o Component A: ViaStainTM Annexin V-FITC  

o Component B: ViaStainTM Propidium Iodide Staining Solution  

o Component C: ViaStainTM Annexin V Binding Buffer  

 Trypsin EDTA (if working with adherent cells) 

 Phosphate Buffered Saline (PBS) 
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1.3 Instrument and Software Requirements 

Spectrum: 

 FCS Express Flow Cytometry software is a product of De Novo Software 

 Spectrum instrument 

 Spectrum software 

 Fluorescence Optics Module S1-534-470 and S1-655-527 

OR 

Vision CBA: 

 FCS Express Flow Cytometry software is a product of De Novo Software 

 Vision CBA instrument 

 Vision CBA software 

 Fluorescence Optics Module VB-535-402 and VB-660-502 

 

2.0 Assay Protocol 

 

2.1 Preparation of Control Samples 

1. A positive control should be used to check exposure time and optimize the y-axis gate for 

    apoptotic and non-apoptotic cells. A positive control may be generated by exposing cells to an 

apoptosis inducing pharmacological agents such as α-TOS and etoposide. For Cellometer 

examples, Jurkat cells were incubated overnight with 10 µM α-TOS or Staurosporine. 

2. A negative control (untreated cells) should be tested to determine baseline cell concentration, % 

    viability, and % apoptotic cells. The negative control is used to optimize the x-axis gate for live and 

    dead cells. 

3. Positive and negative controls should be processed at the same time using the staining and data 

     acquisition procedures outlined below. 

2.2 Preparation of Adherent Cells for Staining 

1. Using 1 x Trypsin-Versene (EDTA), trypsinize cells until they have lifted off the plate. 

2. Spin down cells at 1,000 to 2,000 rpm for five minutes. 

3. Decant the supernatant and re-suspend cells in 1 ml of 1 x PBS.  
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2.3 Staining Procedure 

1. Verify the concentration of the positive / negative controls and cell samples using the Spectrum or 

Vision CBA Analysis System. 

2. Use the Cellometer Sample Adjustment Calculator to generate a cell sample with a concentration 

between 2 and 3 million cells per mL (2-3 x 106 cells/mL). See section 5.0: Using the Sample 

Adjustment Calculator. 

3. Into a new tube, pipette 50 µl of cells that are at a concentration of 2-3 x 106 cells/mL. Spin down   

    cell sample at 200 - 400 x g (~1,000 to 2,000 rpm) for 5 minutes, aspirate medium, then re-  

    suspend cells in 40 µl of Annexin V Binding Buffer (Component C). Mix by 

    pipetting up and down at least 10 times. 

4. Add 5 µl of Annexin V-FITC (Component A). 

5. Add 5 µl of PI solution (Component B). 

6. Gently pipette the cells up and down ten times, then incubate for 15 min at RT (25°C) in the dark.  

7. Add 250 µl of 1x PBS to the sample and spin down the cell sample at 200 - 400 x g (~1,000 to 

2,000 rpm) for 5 minutes. 

8.  Carefully aspirate off the medium and re-suspend cell pellet in 50 µl of Annexin V Binding Buffer 

(Component C). Mix by pipetting up and down ten times.   

 

2.4 Data Acquisition 

1. Select the FCS_Annexin V-FITC + PI or CBA_Apoptosis Annexin V 

+ PI assay from the Assay drop-down menu in the upper left 

corner of the main Spectrum or Vision CBA software screen.  The 

apoptosis assay should be run with the default software settings 

and the exposure times indicated below (2.4.3). If you suspect 

that the settings may have been changed, review the default 

software settings in section 4.0. 

2. If running the FCS_Annexin V-FITC + PI or CBA_Apoptosis Annexin V + PI assay for the first time, 

the default exposure time MUST be updated. Click on the pencil icon under Assay on the main 

Spectrum or Vision CBA screen. 
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3. Adjust the exposure for the Annexin V FITC (F1) and PI (F2) channels based on the instrument 

Instrument Annexin V FITC (F1) Exposure PI (F2) Exposure 

Spectrum 400 msec 250 msec 

Vision CBA 4000 msec 2000 msec 

 

4. To import the most current FCS Express Layout for the Annexin V-FITC / PI assay, see section 6.0 

Importing a New FCS Express Layout 

5. Gently mix the cell sample by pipetting up and down at least ten times, then load 20 μL into the 

Cellometer imaging chamber and insert slide. 

6. Wait 60 seconds for the cells to settle in the chamber 

7. Type a name for your sample into the Sample ID text box 

8. Click Preview Brightfield Image at the bottom left of the main Spectrum or Vision CBA screen. 

 

 

9. Turn the focus knob and adjust focus for the bright field image. Cells in focus for the apoptosis 

assay will have a bright center and dark outline. There should be a crisp contrast between 

background and the cell membrane. See Focus Guide below. 

 

 

 

 

 

 

 

 

Optimal Focus 
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10. Click Stop Preview 

11. Click the Preview F1 Image button (bottom left of screen) 
and verify that the fluorescence signal displays as 100% of 
range. 

  

The default exposure is 400 milliseconds for Spectrum and 4000 
milliseconds for Vision CBA for F1. 
 
 
 
Below shows example images of cell stained with Annexin V FITC + PI. Optimal exposure time will 
generate a bright image with well-defined fluorescent spots. 
 

Under-exposure will yield dark images with insufficient fluorescent signal. Over-exposure will yield 
images that are too bright with fluorescent spots that are less distinct from background.  

 
 
 
 
 
 

 

 

 

 

12. Click Preview F2. The F2 (PI) channel should be set to 250 or 2000 msec exposure for Spectrum 

and Vision CBA respectively. 

 

13. Click the Count button at the bottom of the screen 

 

 

 

 

 

 

 

 

 

 

Under Exposed Optimal Exposure Optimal Exposure 
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14. When counting is complete, an initial Results Table will appear on the screen.  For optimal 
results, the Total Count should be between 2,000 and 8,000 cells (4,000 cells is optimal). If the 
Total Count is < 2,000 repeat data acquisition with a more concentrated sample. For larger cells 
(>15 microns in diameter) a minimum of 2,000 cells is acceptable. 
 

 
 

15. Click the Close button at the bottom right corner of the Counting Results table. Select the BR 
Counted image at the right-hand side of the screen. 
 
 

 
 

 
16.  Review the counted image to confirm that cells are being counted correctly. Individual cells 

within clumps should be circled in green, indicating that they are being counted individually. 
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2.5 Exporting and Saving Data Files 

1. Once cells are correctly counted, click on the report icon at the top left of the screen, then click 
the Export button at the bottom right of the Counting Results screen. 
 

 

2. Confirm that “Export data to Nexcelom Data Package” is selected, and that “When done open 

Nexcelom Data Package with FCS Express” is NOT selected, then click Continue. 

 

3. Select a location and enter a name for the data package. Two items will be saved in the 
designated location with the file name entered: 

 

Raw Nexcelom data file (.nxdat) Folder with cell images 

 

 

3.0 Data Analysis 
 
 

3.1 Opening and Loading Data Files 

If the Nexcelom Data Package is not selected to automatically open, double click the launch 
icon in the designated data package location to open the data file in the FCS Express 
software. 

 

1. Upon opening the FCS Express software, a blank template will automatically load. 
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2. To import data, locate and click on the “Data” tab at the top of the page.  

 

  

3. Locate and click on the folder labeled “Data List” 

 

 

 

4. A data list pop-up window has now appeared. To insert the negative control sample first, click 

on the blue (+) shown in the red circle (below). The Select a Data File pop-up window will 

appear (see example at right). Locate and select your data negative control sample (saved in 

step 2.4.3) and click open.  
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5. Repeat steps 2 and 3 to load positive control and up to four unknown samples. A scatter plot 

and data table generated using default gating parameters are automatically displayed for each 

sample. The generated data is found on page two of the FSC express layout. Click on 

“Apoptosis/Necrosis Results” at the bottom of the page to access the data table. 
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3.2 Gate Optimization 

 

1. You may adjust the gate in the display for the negative control sample only. Adjusting the 

negative control gates will automatically and proportionally adjust the gates in the positive 

control as well as the other data plots. To adjust the gate, first click on the dot-plot. A green box 

appears around the dot-plot singnaling that it is selected. Next, click on the center of the four 

quadrants. A small black box appears in the center (see arrow). You may now click-on and drag 

the gate to a desired location.  

2. The quadrant gating should be adjusted according to data in the negative and positive controls. 

First, the gate should be set based on the negative control. The healthy, live cell population (red 

circle) should be in the bottom left quadrant. 

                  
 

 

 

3. The next gating parameters should be based on the positive control or drug-treated sample. 

Remember that gate adjustments are performed on the Negative Control sample and are 

automatically applied to all plots. Move the gate in the Negative Control while monitoring the 

gate adjustments that are takng place in the Positive Control sample. The necrotic or dead cell 

Correct Gating Incorrect Gating 



Nexcelom Bioscience LLC. | 360 Merrimack Street, Building 9 | Lawrence, MA 01843  

Telephone: 978.327.5340 | Fax: 978.327.5341 | Email: info@nexcelom.com | www.nexcelom.com 

P a g e  | 12 

8001456  Rev.C 

population should be in the top right quadrant. The apoptotic cell population should be gated 

into the bottom right quadrant. 

 

 

                           
 

 

 

4. Upon completing gate optimization, distinct cell populations should now be represented 

individually in each quadrant. 

 

 

 

 

 

 

 

 

 

 

 

3.3 Gate Optimization for Large Cells 

       1.  Dot-plot parameters may need to be adjusted in order to compensate for samples containing 

large cells (typically > 15 microns in diameter). Changes to the dot-plot parameters and gating 

adjustments must be made silmultaneously to all of the plots. To select the plots, press and hold 

down the “ctrl” (control) button on your keyboard and then press the letter “a”. This will select all 

the plots on the sheet. You will notice that red boxes have appeared around all the plots on the 

sheet (see below). 

 

 

Annexin V - positive  
Apoptotic cells 

PI - positive Necrotic cells 

N 

Correct Gating Incorrect Gating 
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2. Navigate to and click-on the “Format” tab at the top of the page.     

 
 

 

4. Under the Format menu, locate and  click on  “Axes”. 

 
 

 

 

 

 

 

 

 

 

 

 

Not selected Selected 
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5. The “Formating Axes” window will pop up. Notice that the default maximum value is 50,000. 

You can now change the scale of the X and Y axis. Change the “maximum” value from 50,000 to 

30,000. To change the X axis, click on “X axis” and also change the value from 50,000 to 30,000. 

 
______________________________________________________________ 

 

 
 

 

 

6. Change the “Transition Point” at the bottom of the page from 300 to 1000. Click OK to save the 

changes.  Adjust gating based on the instructions in section 3.2. 

 

 
 

 

 



Nexcelom Bioscience LLC. | 360 Merrimack Street, Building 9 | Lawrence, MA 01843  

Telephone: 978.327.5340 | Fax: 978.327.5341 | Email: info@nexcelom.com | www.nexcelom.com 

P a g e  | 15 

8001456  Rev.C 

3.4 Saving Optimized Data Files 

1. Following gating optimization, click on the FCS Express icon in the top left corner of the screen.   

 

 

 

 
 

2. Click Save  As 

  
 

 

3.    Click “Embed” in the bottom right of the Save Layout window under Data Files. Enter the desired 

file name and location, then click Save. 

 

  
6. The new .fey file will contain the final analyzed data set 
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3.5 Viewing Image Report 
 

To view the bright field and fluorescent cell images, open the image folder in the original data 

package location. Bright field and fluorescent images are captured for apoptosis (Annexin V-FITC / 

PI) assays. 

        
 

 

4.0 Software Settings 
 

4.1  Review Apoptosis Counting Options Screen 

Click on the Options Page and select Counting Options.  Verify that all selections on the instrument 

screen match the default settings below. 
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4.2 Default Apoptosis (Annexin V-FITC / PI) Software Settings  
 

4.2.1 Check Dialog Screen Settings 

1. Click on the pencil icon under Assay on the main Spectrum or Vision CBA screen.  

 

 

 

 

2. Verify that all selections on the instrument screen match the default settings below. 
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4.2.2 Check Cell Type Settings 

 

 

1. Click on the pencil icon under Cell Type on the main Spectrum or Vision CBA software screen. 

 

 

2. Verify that all selections for the bright field (BR) tab on the instrument screen match the default 

settings below. 
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3. Click on the Fluorescence (FL) tab. 

 

 

 

 

4. Verify that all selections for the Fluorescence (FL) tab on the instrument screen match the 

default settings below. 
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5. Click on the pencil icon under Assay on the main Spectrum or Vision CBA screen, then click the 
Edit button on the right-hand side of the dialog box. 

 

 

6. Verify the Bright field settings for the F2 image. 
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7. Verify the fluorescent settings for the F2 image  

 

  

5.0 Using the Sample Adjustment Calculator 
 

1. Click on the calculator icon at the top of the screen. 

 

 
 
 

2. Select B1 Cell Concentration and click Continue. 
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3. Enter the target number of cells. For the Apoptosis assay, it is 2,000,000. Click Apply Change. 

The required volume of cell sample to be spun down will appear in the Sample Adjustment 

window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6.0 Importing a New FCS Express Layout 
1.  Click on the Support icon in the bottom right corner of the Spectrum or Vision CBA screen, then 

click the “Go” box under Online Resources. Click on the Assay Files tab. Select Annexin V-FITC / 

PI. Compare the date on the Annexin V-FITC / PI layout (.fey file)listed to the version currently 

saved in your Spectrum or Vision CBA software.  
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 To check the version in your software, click on the pencil icon under Assay on the main 

Spectrum or Vision CBA screen. The FCS Layout File name (with date) is listed toward the 

bottom of the Dialog screen. 

 

                 
 

 

 

 

 

 

 

If a newer layout is listed on-line, download the new PI Cell Cycle layout onto your desktop. 

Copy the layout by right clicking on the layout and selecting copy. 

 

2.  Navigate to the START menu and select Computer.  

 
3. Double click on the C: Drive and locate the ProgramData folder (shown 

at right), then proceed to Step 4. IF the ProgramData folder is not 

present, it may be hidden. Follow the instructions below to show 

hidden folders. 
 

3.1 Click the “View” tab (top of screen). 

 
 

3.2 Click on “Options” (top left of screen). 
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3.2 A Folder Options menu will pop up. Select View. 

 

 
 

 3.3 Under the “Hidden files and folders” file, select “Show hidden files, folders, and drives” 

 3.4 Click OK. 

 

4.  Open ProgramData folder, then open the Nexcelom Spectrum or Vision CBA folder. 

5. Open FCS Express Folder, then open the Layouts folder.  

6. Copy the Annexin V-FITC / PI layout from your desktop into the folder. 
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7. Set the new Annexin V-FITC / PI layout as the default layout for the Annexin V-FITC / PI Assay by 

clicking on the pencil icon under Assay on the main Spectrum or Vision CBA screen.  

 

 

 

 

 

 

 

 

8. Navigate to the bottom of the page and click on “Set FCS Layout” 

 

 

9.  Select the Annexin V-FITC / PI layout with the most recent date and click Open, then click Save. 

10.  You have now set the new Annexin V-FITC / PI layout as the default layout for the Annexin V-

FITC / PI Assay on your Spectrum or Vision CBA instrument. 
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7.0 Support 

Warranty 

This product is for RESEARCH USE ONLY and is not approved for diagnostic or therapeutic use. 

Product is warranted to meet the specifications outlined in the Certificate of Analysis when stored 

and used according to the manufacturer’s instructions. No other warranty, expressed or implied 

(such as merchantability, fitness for a particular purpose, or non-infringement) is granted. Warranty 

is valid until the expiration date stated on the product label. If no expiration is listed, the warranty is 

valid for 12 months from the date of product receipt. 

 

Warranty will be void if product is stored incorrectly, the recommended protocol is not followed, or 

the product is used for a different application. 

Ordering Information 

For orders shipping to destinations in the United States: 

 When ordering with a Purchase order 
o Fax a copy of your order to 978-327-5341 
o Email a copy of your order to sales@nexcelom.com 

 When ordering with a Credit Card 

o Visit www.shop.nexcelom.com and place your order 

For orders shipping to destinations outside the United States: 

 Contact your local distributor or Nexcelom Representative to place your order 
 

 
 

  

http://www.shop.nexcelom.com/

